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A WARNING - PLEASE READ

Woodworking can be dangerous! It's up to you to determine if you can safely use
the tools and perform the tasks needed to complete this and any other
woodworking project. If you are unsure, STOP! Get advice from someone
knowledgeable or do some careful studying on your own. Be safel!

Always wear at least an appropriate N95 dust mask or respirator when sanding or
spraying any finish. For advice about dust masks and respirators, visit this link:
https://woodworkingtoolkit.com/best-dust-masks-respirators/

This Is Not Standard Documentation - Fill In the Blanks

I generated the original material in this ZIP package just for me, not for a general
audience. This gave me the freedom to create a minimal amount of written design
documentation. And it allowed the documentation o be technically incomplete. T
simply carried some ideas around in my head.

Please be aware that I might not have included every detail that you need to build
this project. So I suggest that if you want to build it, carefully look things over
and determine ahead of time if you have enough information to go forward.

It might be sufficient to simply guess at any needed information if you can't find it
in the included files.

Please be aware that there might be mistakes in the documentation that T
accounted for during the build but failed to note in the documentation.
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Non-standard Dimensioning

My attitude toward dimensioning is o make it "good enough.” Professional
mechanical designers follow certain conventions regarding dimensioning. I'm not
that careful. So understand this ahead of time when you find any dimensioning that
is unconventional.

The JessEm Dowelling Jig Box Project
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Figure 2. Open Box Showing Some Inner Details o
The JessEm Dowelling Jig Box is a convenient place to store the JessEm Model

08350 Dowelling Jig Master Kit, available from Amazon:
https://tinyurl.com/y35ovrfg

All of the jig's components are stored conveniently and efficiently in a box that
measures 12 11/32" L x 6 3/4" W x 4 1/4" H.
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Figure 3. Closed Box Showing the Handle, One Latch, and Dowel Joinery

Some of the Box's features:

e The Top and Bottom are captured in dados

e The Sides are rabbeted to ensure accurate registration with the Ends

e Dowels are used to strengthen the joinery at the corners

e The Box is assembled as a simple, 6-sided box, and then the top is removed
using a table saw

e The Box is compartmentalized with a separate section dedicated to each
component of the jig

¢ Glue: Titebond IT or equivalent

o Finish: Amber shellac (or your choice of finish)

A SketchUp File and an Equivalent PDF File

File JessEm_16.skp is the SketchUp design file for the Box. This file is useful if
you are using SketchUp or SketchUp Viewer since I think all of the necessary
details are incorporated here. So, for example, if you find a dimension or other
detail missing, it can be determined by examining this file. And, you can orbit, move
the model around, or even hide components for a better look at every detail.
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File JessEm_16.pdf contains all of the images and dimensions from the SketchUp
file. Use this if you don't have SketchUp or aren't familiar with it. Also, you can
easily print this file so that all of the details can be available while you're
working in the shop.

For anyone who doesn't have SketchUp and chooses not to depend on the PDF file,
a free SketchUp Viewer is available:

https://www.sketchup.com/products/sketchup-viewer

Some Drawing Details are Missing

Certain details are deliberately missing. For example, dowels are used to
strengthen the joinery at the corners (see Figure 3) but they're not shown in the
design drawings. You should rely on the photographs and the information that
follows to determine their placement.

Dowels

The dowels at the Box's corners have a diameter of 3/16-inch and are 1 inch long.
They're trimmed flush with the outside surface.

The dowels are all centered along the edges of the Ends that they extend
into. Their vertical placement is as follows.

Top Dowels: 7/8" from the top edge of the Box (do not attempt to
estimate their positions by measuring from the bottom
edge of the Box)

Middle Dowels: 2 1/8" from the bottom edge of the Box (do not attempt to
estimate their positions by measuring from the top edge of
the Box)

Bottom Dowels: 7/8" from the bottom edge of the Box (do not attempt to
estimate their positions by measuring from the top edge of
the Box)
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Details of the Project

The information that follows will help o make clear the details of each component
so that possible misunderstandings might be avoided. Each of the Box's components
is discussed. Use the included SketchUp or PDF file to follow along with these
descriptions. The paragraph headings below correspond to each tab or page in
the SketchUp and PDF file.

3/4 View Closed

The Box is formed as a simple, 6-sided box. The Top is then separated from the
rest of the Box using a table saw. This image shows the location where the saw's
blade (about 1/8" wide) cuts through both Sides and both Ends of the Box.

3/4 View Box Exploded

Here you can see how the components of all 6 sides are related to one another.

The 3/16" x 1" dowels that strengthen the corners of the Box (see Figure 3) are
installed once the components are fabricated and assembled. Refer to Page 5 for
details about the dowels.

Cut the Top off of the Box with a table saw at the location marked in the 3/4
Closed image. Before making the cut, be sure to make witness marks on what will
become the Top and what will become the rest of the Box so that you can orient
the Top of the Box to the rest of the Box correctly once they have been
separated. This will ensure a good fit and agreement with each other.

Internal Arrangement 1

This drawing shows the view with the Box's Top, Bottom, Sides, and Ends all
removed.

The Sideboards are the 3/4" plywood along each side. The Sideboard at the
bottom of the image holds the jig's 3 indexing pins and Allen wrench.
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As viewed from left to right looking down on the components, you can see the jig's
1/2" Guide Bushing assembly (Goldenrod), Divider#4 (Cyan), 1/4" Guide Bushing
assembly (Goldenrod), Divider#1 (DeepSkyBlue), 3/8" Guide Bushing assembly
(6oldenrod) attached to the plate of the jig (6ray), and finally Divider#3
(LightPink). Divider#2 is the Magenta object below the plate of the jig (Gray).

Internal Arrangement 2

This image is the same as the Internal Arrangement 1 image but with all of the
Jig's components removed. This image reveals more details of the Box. In
particular, the Bit Cover (GreenYellow) is now easily seen.

The Bit Cover contains two 1 1/4" diameter holes. You can use your index finger and
thumb to remove the Bit Cover as shown in Figure 4.

o

Fig;:e 4. Bit -C.c;ver'hBeing liemoved
The Bit Cover helps to contain the 3 drill bits with their stop collars. It also
provides a place for the jig's plate to rest.

Also partly visible in Internal Arrangement 2 are dowels secured in two of the
dividers. Divider#4 (Cyan) has two 1/2" dowels installed in it. Divider#1
(DeepSkyBlue) has two 1/4" dowels installed in it. See Figure 5.
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Figure 5. 1/2" Dowels and 1/4" Dowels in Dividers

Notice the notch in Divider#1 at the right in Figure 5. The notch is necessary to
accommodate the two longest drill bits. Be sure that Divider#1 (DeepSkyBlue)
is installed in its correct location and correct orientation so that the longest
drill bits will fit in Box.

The ends of the dowels are flush with the back surfaces of the dividers in Figure
5.

Figure 6 shows how the notch in each guide bushing slides over the dowel pins so
that the guide bushing is supported and aligned inside the Box.

Figure 6. The Dowels Support the Guide Bushing Assemblies
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Internal Arrangement 3

This image is similar to Internal Arrangement 2, except that the Bit Cover has
been removed. With the Bit Cover gone, you can more easily see the Bottom Plate
(DodgerBlue) and the 4 Separators (Separator#1 (MediumOrchid), Separator#2
and Separator#4 (both are DarkMagenta), and Separator#3 (Plum).) All of the
Separators are glued to the Bottom Plate such that the ends of the
Separators are flush with the ends of the Bottom Plate.

The 4 Separators provide 3 spaces between them for storage of the 3 drill bits. A
gap between the Bottom Plate and Divider#2 (Magenta) allows room for the stop

collars on the 3 drill bits.

Internal Arrangement 4

This a plan view of the internal portions of the Box with the Bit Cover removed.
Key dimensions are shown.

The two Sideboards (Khaki and Peru) are glued to the Sides and Ends of the Box,
so the 5 13/16" dimension and 4 3/8" dimension are dependent on the internal
Box dimension and, therefore, approximate.

The three largest holes in Sideboard#1 (Peru) are for the jig's indexing pins.
Notice that the holes’ centers are offset from the centerline of Sideboard#1.
This is so that the heads of the indexing pins are moved far enough from the
centerline so that they won't interfere with placing the Top onto the Box.

TWO OF THE DIVIDERS
The two Dividers toward the left, Divider#4 (Cyan) and Divider#1 (DeepSkyBlue),
must be located at the dimensions shown. And, each must be square to the

Sideboards and square to the Bottom of the Box.

The dowels must be glued into each Divider so that the end of each dowel is flush
to the back side of each Divider.
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One way simultaneously to get the Dividers square to both the Sideboards and
Bottom of the Box while gluing them into place is to use a rectangular block of
wood. Cut a block of wood with no smaller than a 2"“x2" cross section, and several
inches long. Be sure each face of the block is square to each of its adjacent faces.
Thoroughly wax the block to prevent glue from adhering to it.

With the wood block simultaneously held against the Divider, a Sideboard, and the
Box Bottom, locate and glue each Divider into place. Remove the block as soon as
possible to prevent any glue from adhering to it.

Be sure the notch in Divider#1 (DeepSkyBlue) is toward Sideboard#2 (Khaki).

BOTTOM PLATE AND SEPARATORS

Locate the Separators on the Bottom Plate as shown. The ends of each Separator
are to be flush to the ends of the Bottom Plate. Separator#1 (MediumOrchid) at
the top, and Separator#3 (Plum) at the bottom are each flush to one end of the
Bottom Plate. The other two Separators (#2 and #4, both DarkMagenta) must be
positioned on the Bottom Plate as shown.

Once the glue on the Separator-Bottom Plate assembly has cured, butt the
assembly against Divider#1 (DeepSkyBlue) and glue the Bottom Plate o the
Bottom of the Box.

DIVIDER#?2

Divider#2 (Magenta) is fashioned from a piece of 15/32" plywood sandwiched with
piece of 1/8" plywood. This forms an assembly with two rabbets. The assembly is
glued against the ends of the Sideboards and the Bottom of the Box.

DIVIDER#3

Divider#3 (LightPink) is glued against the End of the Box and the Bottom of the
Box.
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Top Bottom

The Top and Bottom pieces are identical. Each is nominally 1/2" plywood with a true
thickness of about 15/32". ITts dimensions are set so that it will not "bottom out” in
the dados or along the inside edges of the Sides and Ends. Be sure to do a dry fit
to test the fit before attempting to glue the pieces together.

When cutting the rabbets, be sure to cut them deep enough so that the
resulting tenons will fit nicely into the dados of the Sides and Ends.

Ends

The Ends are simple pieces of 1/2" plywood (true thickness: about 15/32") with a
dado along two edges.

Sides

The Sides have two important features. First, they each contain two dados that
capture the Top and Bottom.

Second, they feature rabbets that accommodate the Ends so that the Ends
register correctly with the Sides.

Dividers

There are 4 types of dividers. All but Divider#2 are simple.

Divider#2 (Magenta) is unique among the Dividers. It's formed with a 4 3/8" x 2" x
15/32" piece of plywood sandwiched and glued to a 5 13/16" x 2" x 1/8" piece of
plywood. This forms an assembly with fwo rabbets that fit against the two
Sideboards as shown in the Internal Assembly 4 drawing.

Bit Cover

The Bit Cover serves two purposes. First, it covers the 3 drill bits with stop collars
so that they are captured in place.

Second, it provides a shelf where the plate of the jig rests.
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Two 1 1/4" diameter holes are drilled in the Bit Cover so that you can use them to
remove and replace it in the Box. Look at Figure 4 to see how this is done.

Like Divider#2 (Magenta), the Bit Cover is formed by sandwiching together two
pieces of plywood. One piece is 3/4" thick (more correctly, 23/32" thick.) The
other is 1/8" thick. Now, this should form a piece that's less than 7/8" thick, but
with the glue included, the actual thickness is nominally 7/8".

Bottom Plate

This is a simple plywood component that doesn't require any commentary.

Separators

Four Separators are used to provide spaces for the 3 drill bits and bit collars.
They're glued to the Base Plate such that their ends are flush with ends of the
Base Plate. Note that the Base Plate is almost square inasmuch as one edge is

4 9/32" and the other 4 3/8", a difference of only 3/32", so be careful that the
Separators are oriented correctly on the Base Plate.

Notice that the height of all of the Separators is 21/32", a non-standard plywood
dimension. Certainly, the 3 narrow separators can be cut to the desired 21/32"
width; simply select the correct plywood material (15/32" thick and 1/4" thick) and
cut to a width of 21/32".

However, to create Separator#3 (Plum), use a table saw to cut 23/32" material to
a thickness of 21/32" and then cut it to the required width of 11/2".

Note that, though Separator#2 is distinguished from Separator#4 by name, they
are the same dimensions and the same color, DarkMagenta.

Sideboards
The two Sideboards have the same overall outer dimensions but Sideboard#1

(Peru) has a lot of details cut into it. Sideboard#1 provides storage for the jig's 3
indexing pins and Allen wrench.
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The slot where the Allen wrench is stored can be cut in a couple of different ways.
Figure 7 shows the result when the slot is cut using a table saw and dado blade.
Alternatively, the slot can be cut on a router table.

TABLESAW
Figure 7. Slot Cut with a Table Saw
The centers of the holes for the 3 indexing pins are offset from the centerline of
Sideboard#1 so that the heads of the indexing pins are offset so that they don't
interfere with Top of the Box. You can see in Figure 7 that the heads of the
indexing pins don't extend past the outside edge of the Sideboard, so they won't
interfere with the Top of the Box when it's placed onto the Box.

Referring to the Sideboards drawing, the holes for all three of the jig's indexing
pins are centered 5/16" from the inside edge of Sideboard#1. This puts the hole
for the 1/2" indexing pin (the one at the far left in Figure 7) very close to the
edge of Sideboard#1. But Divider#1 (DeepSkyBlue) is glued against this edge as
seen in the Internal Arrangement 4 drawing so that there is no danger that the
thin wall will fail.

Be sure to notice that the hole for the Allen wrench, unlike the indexing pins, is
centered on the centerline of Sideboard#1.

Also, since the dimension lines are spaced together so closely, it's important to be
clear that the slot width is 1/4".
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Dowels

A total of 4 Dowel pins are glued into Divider#4 and Divider#1. Two have a
diameter of 1/4". Two have a diameter of 1/2". All are 11/2" long. Each Dowel pin is
driven into its respective Divider until its end is flush with the back surface of the
Divider.

All Wood Components

You can ignore this drawing if you don't use SketchUp.

This drawing contains all of the wooden components of the Box. All jig components
have been removed. You can see the individual components if you are using
SketchUp. Simply hide any or all of the outer components of the Box.

The purpose of this drawing is to provide a convenient means of invoking the Cut
List Extension of SketchUp. Just drag your mouse from right to left across the
drawing to select all of the Box's wood components in preparation for using Cut
List.

I recommend that you download and install the Cut List extension for SketchUp if
you haven't already done so.

How to Download Cut List if You Have Not All Ready Done So: From
SketchUp, select Window > Extension Warehouse. Then enter cutlist (one
word) in the search window and click the Search button. CutList by Steve. R
should appear on the list. Select, download, and install this extension.

To invoke Cut List, drag your mouse pointer from right to left across the drawing
to select all wood components. Then click on Extensions > Cut List. Select the
desired Cut List 4.1 options and then click Run.

Handle Hole Pattern

This drawing provides details showing the handle hole pattern. The handle used on
the project is described on Page 18 under Hardware.

If you DO NOT have SketchUp, you can simply duplicate the drawing's dimensions
onto your project to layout and drill the holes.
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If you DO have SketchUp, you can print a full-size copy of this drawing and use
it o layout and drill the holes.

To print a full-size copy of this drawing: From this page, select File >
Print... or Ctrl-P to open the printer dialog box. Under Print Size, make sure
that the Fit to page check box is not checked. Under Scale, enter 1 in the
boxes next to both In the printout box and In SketchUp box. Click OK. The
printer will issue multiple pages.

Using the utmost care, align one sheet with the other to form the complete
hole pattern. (You might want to use scissors to cut away unneeded
material.) Use small pieces of tape to tack one sheet to the other sheet.
Once you're satisfied that the completed patchwork pattern is accurate,
secure the pages together with a long piece of tape.

If you've printed the full-size copy, use the vertical and horizontal centerlines in
the drawing to center it with the Top of the Box. Transfer the hole centers using
an aw! pressed through the paper and onto the Top. Drill the holes.

Latch Hole Pattern

This drawing provides details showing the latch hole pattern. The spring-loaded
draw latches used on the project are described on Page 18.

If you DO NOT have SketchUp, you can simply duplicate the drawing's dimensions
onto your project to layout and drill the holes.

If you DO have SketchUp, you can print a full-size copy of this drawing and use
it to layout and drill the holes. Follow the process described under To print a full-
size copy of this drawing on Page 15.

If you've printed the full-size copy, use the vertical and horizontal centerlines in
the drawing to center it with each End of the Box. Locate the indicated line on the
boundary between the Top and the rest of the Box. Transfer the hole centers
using an aw! pressed through the paper and onto the Ends. Drill the holes.
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Other Information

The description of the JessEm_16.skp and/or JessEm_16.pdf drawing is how
complete. The following is additional information that you might find helpful when
building the JessEm Dowelling Jig Box.

The Amended Cut List Output

Table 1, below, is useful whether you're using SketchUp or referring to file
JessEm_16.pdf. For those using SketchUp, the following lead-up to the table is
helpful. For those using file JessEm_16.pdf, go directly to Table 1.

You can create a cut list for the Box if you have SketchUp with the Cut List
extension. Do so by going to the All Wood Components drawing and dragging from
right to left across the Box in to select all of the wooden items in the Box. Then
run the Cut List extension. If you do that you will produce a cut list.

You can generate an amended cut list if you also follow the instructions at
https://bobpenoyer.com/sketchup sup.htm.

Look at Table 1.
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FILE: JessEm_16_CutList_ MATCHED.txt

Part# Quantity Description Length(L) Width(W) Thick(T)
C-eol 2 Dowel#1 11/2" A 1/2" 1/2"
C-002 2 Dowel##?2 1 1/2" A 1/4" 174"
S-001 1 Bit Cover Plywood 4 7/8" 4 11/32"| 7/8"
S-882 1 Bottom Plate Plywood 4 3/8" B E |4 9/32" 15/32"
S-083 1 Divider#l Plywood 4 3/8" B H|3 3/16" 15/32"
S-ee4 1 Divider#2 Plywood 5 13/16™ | C 27 19/32"
S-885 1 Divider#3 Plywood 5 13/16" C H|3 3/18" 15/32"
S-006 1 Divider#4 Plywood 4 3/8" B H|3 3/16" 15/32"
S-007 1 End#1 Plywood 6 1/16" D B|4 3/8" 15/32"
S-088 1 End#2 Plywood 6 1/16" D B |4 3/8" 15/32"
S-009 1 Separator#l Plywood 4 9/32" E 3J|21/32" 1/4"
5-018 1 Separator#2 Plywood 4 9/32" E J1|21/32" 15/32"
S-811 1 Separator#3 Plywood 4 9/32" E A|11/2" 21/32"
$-012 1 Separator#4 Plywood 4 9/32" E J|21/32" 15/32"
5-013 1 Side#1 Plywood 12 11/32" | F B |4 3/8" 15/32"
5-014 1 Side#2 Plywood 12 11/32" | F B |4 3/8" 15/32"
$-015 1 Sideboard#l Plywood 9 3/32" G H|3 3/18" 23/32"
S-8le 1 Sideboard#2 Plywood 9 3/32" G H|3 3/16" 23/32"
S-017 2 Top Bottom Plywood 11 11/16" 6 1/8" 15/32"

Table 1. Amended Cut List

Table 1 has a very useful feature. All of the length and width dimensions in the
blue box are cross-matched by the labels in the red box. So, for example, every
item labeled "A" has a 1 1/2" dimension, every item labeled "B" has a 4 3/8"
dimension, every item labeled "C" has a 5 13/16" dimension, etc. All items with a
given label have the same dimension. (Items with unique dimensions are not
labeled.) The labels make planning your cuts much easier. Instead of scanning
through a list of confusing dimensions, simply look at the labels to identify all
cuts that can be made using the same setup.
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Hardware

The handle is the F982 - 3/4"" x 8'' Formed Steel Tool Box Handle, made by
Smallbox Hardware and available from Amazon: https://tinyurl.com/y4ffha8k

The spring-loaded draw latches are the 4 Set Stainless Spring Loaded Toggle Case
Box Chest Trunk Latch Catch Clamp Clip, made by MEKBOK and available from
Amazon: https://tinyurl.com/y5dgdkvn

Machine screws are used with T-nuts with to secure the handle to prevent the
heavy weight of the Box from pulling out wood screws. The T-nuts are shown in
Figure 8.

Dimples to ensure
correct orientation

Figure 8. Hardware Details

You can also see a dimple on the Top and a matching one on the other part of the
Box. These were referred to as "witness marks" in the 3/4 Box Exploded drawing
description on Page 6. You can ensure the proper registration of the Top with the
rest of the Box by always keeping the dimples (or whatever marks you choose)
together.
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